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Product Overview

Thanks for purchasing this useful and powerful product!

The Pocket Pen Tablet can capture any handwritten notes or drawings on a plain
paper and store them in its internal flash memory. Captured notes can be uploaded to
computer via its USB interface. It really helps when you are away from computer and
needs to capture any instant thoughts or important points.

The Pocket pen tablet consists of a digital pen and a small receiving unit, which
combines Ultrasound and Infrared technologies with sophisticated algorithms to
enable an accurate tracking and positioning system that tracks the movement of the
tip of the pen on any surface and converts the movement into a vector image of the
user’s handwriting. The digital pen transmits handwritings to the receiver unit for
storage.

The following chapters will describe both hardware and software features of the
device in details. Read the Quick User Guide before operation. For detail information
about the device, please read the included User Manual on the CD provided with the
package, so that you are aware of some useful functions that you may not know.



Key Features
e Capture natural handwritings and drawings while being away from computer.
e Save captured handwritten notes into built-in flash memory.
e Upload captured handwritten notes to computer via USB connection.
e Act as a digital ink pen with hovering and mouse functionality to directly write
into Windows Vista and Office 2007.
¢ No installation is required to activate digital ink in Vista and Office 2007.
¢ No need for special paper.
e Standard off-the-shelf ink refill and batteries.

Package Content

e Digital Pen e ink refill

e Base unit e Quick Start Guide
e USB cable ¢ Warranty Card

e Pen battery ¢ Note Manager CD

Chapter 1 How to use the Digital Pen

Your Pen is a unique device that captures notes handwritten on plain paper, and
transmits them to the base unit

The Pen Uses patented technology combining Ultrasound and Infrared technologies
with sophisticated algorithms to enable an accurate tracking and positioning system
that tracks the movement of the tip of the pen on any surface and converts the
movement into a vector image of the user’s handwriting.

Installing/Replacing an Ink Refill into the Pen
The top of the pen cap also functions as an ink refill extractor.
NOTE: Make sure you use a refill that is similar to the original (standard refill (67.0mm
long X 2.35mm diameter).
To replace the ink refill:
1. Detach the cap from the digital pen.
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2. Insert the ink refill into the cross of 3. PuII the used Refill out.
the extractor with pressure so that
the extractor holds the refill firmly.
Hold the pen firmly, and apply
pressure with the extractor against

To insert a new refill
1.  Slide the new refill into the tip of the 2.  Gently press the new refill until it
pen. is lodged securely in place.

&‘\\L\b

Installing/Replacing Pen Batteries .

(1) Remove the battery compartment cover.

(2) Install two SR41 batteries, with the positive poles facing up.

(3) Supplied batteries are good for initial use only Replace battery
compartment cover.

Notice: —

¢ Please use the enclosed GP SR41 batteries with the positive polarity facing
up.

e Batteries may be safely disposed of in normal household waste.
Contact your local government for disposal or recycling practices in your area

e Caution: Risk of explosion if battery is replaced by an incorrect type
Please use silver oxide button cells battery type only.

e When your Pen battery runs low, the following message appears on your
screen:

i
() Low Battery Detected %]
" Your pen batteries are low!
Please replace them as soon as possible.
For help please consult the User Manual.




This warning is continuously displayed on each new note and the application tray icon
in the system tray changes to reflect the current status until the batteries are replaced.

Tray icon indiocation, for Pen low  Tray icon indiocation, for Pen low battery,
battery, in Note Mode in Mouse Mode.

Z 5

Note: Lifetime of the batteries may vary and cannot be guaranteed.

Write Correctly

When you pick up the pen, find a position that is

comfortable for you. Be careful to hold the pen in a way M
that does not block the signals sent from the tip of the pen | %
to the memory unit receivers.

When you are writing with the digital pen, make sure its
inclination to the paper surface is between 45°and 90°.

Hold the pen firmly and write normally.

For better writing quality

[ 4 r . i . = = oy / .
L ¥ A | y ) ; | oy .

Do not block the base Do not place your Do not hold the pen
unit with your hand. hand between the like a paintbrush.
pen and receiver.

A WARNING:
Do not attempt to open the Digital Pen.
This may cause the pen to malfunction.




Chapter 2 Base Unit

General Overview

The Pocket pen tablet is a unique device that captures notes handwritten on plain
paper, Stores the notes to memory and uploads them to a PC.

The device consists of a Digital Pen and a small receiving unit.

The Pocket pen tablet uses a patented technology combining Ultrasound and Infrared
technologies with sophisticated algorithms to enable an accurate tracking and
positioning system that tracks the movement of the tip of the pen on any surface and
converts the movement into a vector image of the user’s handwriting.

The Mobile Pocket pen tablet can capture and store up to 50 A4 pages.

At home or in the office, the user can connect the Mobile Pocket pen tablet to the PC
using the USB cable, then upload and manage the saved notes.

Getting To Know Your Memory Unit

Buttons & Ports
The memory unit consists of an LCD for status indications.
The memory unit also consists of a single button allowing you to turn the unit ON and

OFF, as well as creating a new file.
A. Reset hole — When the unit does

% not respond, stab into this hole to

] reset it and then press and hold the
A B Top button to restart the unit.

B. USB port — connect to computer
through the USB cable

LCD display

Top button — Press and hold for
about 5 seconds to turn on the unit.
Press shortly to create a new note.
E. Paper Clip — clip the unit to paper

O

o

Note: Actual appearance of the base unit may differ from the illustration depending on
the model, but functions are the same.

Turn on/off the Unit

Press and hold the Top button to turn on or off the unit before you use the base unit in
mobile mode.

NOTE: The unit will power off automatically after 60 minutes of idle time (no working).



Charge the Battery
Your Pocket pen tablet includes a rechargeable internal battery. Each time you
connect your unit to your PC USB port, the batteries are being charged. Full charge

time takes about 3.5 hours.

Reset the Base Unit
If the base unit is frozen, you can use a pin to press the Reset button to reset it and
then press and hold the Top button (ON/OFF button) to restart the unit.

Memory Unit LCD
Use the LCD to view status indications.

Name On when Off When Blinks When
1_,-@'1 Mobile Unit is connected to PC Unit is NOT Data is uploaded to
Pocket pen connected to PC
tablet is PC
Connected
Memory Mobile Pocket pen tablet Less than 90% | Never
FULL Unit Memory is 90% full. capacity used
It is highly recommended
to upload your files to
your PC and delete them
from memory!
ﬁ Pen Low Low Pen battery Pen Battery Low Pen battery
Battery good
@nn Base unit Full Unit is Off Charging
Low battery
Note Mode Pen down/Pen move Mouse Mode Pen down/Pen
/ move
\6 Mouse Pen down/Pen move Pen Mode Pen down/Pen
Mode move
"_-' 'j Number of Always Unit is Off Memory full Or
e saved notes Error
in memory

Power Save mode
In order to save power from the rechargeable battery, while in mobile mode, if there is
no activity (Meaning: No Pen usage nor key press on base unit), your base unit will
automatically shut down in 60 minutes. Your note will be automatically saved.

To exit power save mode, simply press ON/OFF button on the unit to turn it on. (Note:

This will start a new note file).




Chapter 3 Use your Pen Tablet in Mobile Mode

In the mobile mode, you can use your Pocket Pen Tablet to take and store your
Important notes or drawings at any time and where.

Mounting your Base Unit to Paper
Your base unit can be mounted in 3 positions on top of the paper depending on
various deivce model.
The following images illustrate the way you can mount your base unit, according to
the recommended positioning.
A. Mounting your base unit at the top center of the paper is recommended
for a single paper usage:

=

B. Mounting your base unit at the top left corner of a paper block is
recommended for right hand Users.

[
C. Mounting your base unit at the top right corner of a paper block is
recommended for left hand Users.

- 1 -

Base Unit Coverage area:

The following images illustrate the coverage area of your base unit.

Note: a. The paper is an A4 size paper; b. The striped line illustrates the covered area
in each of the positions.



Base unit located at the Base unit located at Base unit located at
left corner. the right corner. the top center.

c N -

Warning:
DO NOT move or overturn the base unit when you are using the base unit. Fix it up

onto the edge of the paper with the face up. Moving or overturning it may result in
mixed strokes or other fatal errors.

Take handwritten notes

(1) Press and hold the ON/OFF button to power on the unit.
(EmE|

¥
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(2) Hold the base unit and gently press the paper clipper.

(3) Slide the base unit into the paper’s upper edge and make sure the base unit is
in the center.

(4) Pick up the digital pen and start writing. (NOTE: Be careful to hold the pen in a
way that does not block signals sent from the tip of the pen to the receiver unit.)

I

(5) Once you've completed one page, shortly press the ON/OFF button to save
current page and start a new page. On the base unit screen, you can see the
page number added by one.

(6) All notes are stored in the base unit. You can upload them to a PC for viewing,
editing, or email.

Chapter 4 Use your Pocket Pen Tablet in
Connected Mode

Connect your Pocket Pen Tablet to the computer with the USB cable, the device



works in the connected mode. Once connected, you can view, edit, send or print your
notes. Also, you can take notes and make drawings just as you do in mobile mode.
The digital pen can also acts as a mouse with features like hovering, left and right
click. Additionally, there are some special features to be used only with the connected
mode. Those features will be described in details in the followed chapters.

Before you connect the device to a PC, first make sure to install the Pocket pen tablet
manager application included in the CD and run it.

Install the Software Suite

Your product is packaged with a CD that includes its companion desktop software —

Note Manager. With the software, you can upload notes to computer, view or edit the

notes.

System Requirements:

o] Microsoft ® Windows 2000 (SP4) or Microsoft ® Windows XP (SP2) or

Microsoft ® Vista or Windows 7.

Minimum 50MB available hard disk space

Minimum 128MB RAM

32 bit color quality

Screen resolution of 1024x768 pixels

o Available USB port.

(1) Insert the installation CD into your CD ROM drive. The setup program should
start automatically. If not, run the program by selecting ‘Run’ from the Windows
‘Start’ menu and type in D:\setup.exe. If your CD drive uses a different letter,
type that letter instead of D.

Trotal V5hield Wiznrd

O O O O

Preparing to Install

(2) Follow the instructions on the screen.

10



Imzinl iShirld Bigard

E Prapatieg to lnsisl.

iy i bt ) Sl o6 [ i Beemnk Shanid Wirsinl
which wall st o Sergh o DO SFRE DORTL
Flans wasl

ek v (s ), Ty iR e

£ - 1wt k) WAz = x
Welcome to the InstallShield Wizaad for
HotaTaker Software Vedtion 3.4.60

The ettt ) wWerd wil ratsl MowT s foftews
arurs 14 A0 o your computer, T contn, cick At

VRTIENEL: Ths oy e i DA oMce] By C0p i M
i huterl S

shorr Softare Vrrsion S50 - (sl Wiz
D tirsation Fikder L
Chch Fat T rwal 0 T e, or clck Changs 1 el 56 e foioe -‘

rortad bl | i SeSwas viener 1450 E

Ly v e o e, e

s

L e

Bpaly B0 Bl e Progeam

el w3 A Py O S PR,

ik sl o b B piiatew.

IF i el 1 v (F clire iy of rOuF Pelalitns e, O Back. Tk Caresl i il
LE ]

b
(3) Click “Finish” once the installation is finished.
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Note: After the installation process, when running the application for the 1 time, a
new folder named “Ink Notes” is created in your “My Documents” directory. All your
notes will be saved into this directory. In the event that no “My Documents”
directory is found, the installation process will create a new “My Documents” folder
on your C hard drive. The ‘Ink Notes’ folder will then be created under this
directory. If you uninstall, upgrade or reinstall the software in a different location,
the note files will remain in this directory, and will not be overwritten.

Run the Software
Select “Programs”—> “Pocket pen tablet” from the Windows “Start” menu to run the

Note Manager.
[T Aloix)
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Connect Memory Unit to Computer
Use the Mobile Pocket pen tablet’'s
mini USB connector to plug in the
USB cable (included in the package),
which connects the unit with the PC
when uploading notes.
Note: Only use the USB cable
supplied with your Mobile Pocket
pen tablet package.
The USB cable (included in the
package) plugs into the Memory Unit
Connector and is used for the following:
e Uploading notes from the memory unit to the PC
¢ Working in Connected Mode
e Firmware updates
Important Notice: Do not connect more than one set of this device at the same time.
That may cause interference with each other.

12



Uploading Notes to your PC

Connect Memory Unit to Computer
When in Connected Mode, you can upload all your notes from the memory unit to
your PC using the Pocket pen tablet software application.
Before doing so, first make sure that:
e Your Note Manager software application is running
e Your memory unit is connected to your PC’s USB port using the memory unit
USB cable.
5
The “CONNECTED” icon will be displayed on your memory unit LCD: =
Application Tray Icon will change while uploading your notes: E:E
Port Auto-Detection
Once you launch the application, the Pocket pen tablet software automatically detects
your hardware.
The application automatically searches all ports in order to detect the hardware. If it is
unable to locate the connection, the Hardware Detection dialog box appears.

% Device not found E

™ Unable to find device, please make sure the device is
connected propetly.

] o

USB Hot-Insertion

USB Hot Insertion refers to connecting the USB cable while the application is running.
The application will auto-detect your hardware if the USB cable is disconnected while
the system is running and then re-connected. The application will also auto-detect the
hardware if you first run the software and then connect the USB cable.

When you plug your Mobile Pocket pen tablet unit (If the application is running), you
will be asked if you want to upload your notes from the Mobile unit memory to your
Note Manager.

<P Wour Mobile NoteTaker was detected.

Do you want to upload wour notes now?

™ Do not agk me again.,

Setting your base unit orientation preferences
Your base unit can be placed the top center of an A4 paper.

13



Pen Mode and Mouse Mode
The device supports a Note mode and a Mouse Mode. In the Note mode, you can
write and draw pictures with the pen. In the Mouse mode, the pen acts as a mouse
with click and hovering function.
Selecting default mode can be done in 2 ways:

a. At the first time you start your Pocket pen tablet application, OR

b. Using the Pocket pen tablet “Configuration” menu (‘Set Digital Pen Mode’)
Changing modes during operation can be done in 2 ways:

a. Press the base unit top button (‘Mode’ button) , OR

b. Right click the ‘Pocket pen tablet’ tray icon, and change mode, OR

c. Clicking on the virtual area using your pen.

To change mode,
tap your Digital Pen-at this area

LI LI

"
E |
[
|

Virtual Area: :—
-
|
I

Note: On each mode change, a Balloon will popup indicating the current mode and
the corresponding LED will lit.

Uploading Notes
(1) Start the Note Manager.
(2) In the “File” menu, select “Upload”, or click in the upper toolbar. All the
notes in your memory unit are uploaded to your PC.
(3) At the end of the process, a message appears asking if you want to delete all
notes on the memory unit. Select ‘Yes’ to erase all notes on your memory unit.
Select ‘NO’ to retain the notes.

Enay note taker

‘?r"l Do you want to delete all notez on wour deviee?

[ &= || Fw

(4) Uploaded notes will be saved in the Mobile Notes folder named by date.
NOTE: When you select “NO”, the next time you upload those notes that are already
uploaded to the PC Will not be uploaded.

14



However, if you delete notes from the PC application and then upload again from the
memory unit, the notes will be uploaded again.

You can select one of three options to be performed automatically when your Mobile
Pocket pen tablet base unit is connected. The following can be selected in the

‘Configuration -->Preferences’ menu within the Note Manager.

Upload new notes automatically options:

YES — Your Mobile Notes will be automatically uploaded mpwm.n| )
each time you connect it to your PC R

NO — Your Mobile Notes will not be uploaded. In this EEim

option, you will manually need to perform this action by

selecting “File” --> “Upload” menu within the Note

Manager

ASK ME - Each time you connect the Mobile Pocket

pen tablet base unit, you will be prompt if you want to ok ] comed | bob

upload your notes.

Viewing Notes
You can view your note on the computer screen.

(1) Run the Note Manager.
ET

Fle Edit VWiew Configuration Help

B2 @a - s B2X 38 & EEE L 2
i My Notes (8)

-3 Miscellaneous
-7 Deleted Items
i [11 Received Not Fh

H g,
- [ Mobile Motes

+- [ Contacts
*- 23 Follows Lp

KN

1 items selected, Z

(2) Click the “Mobile Notes” folder in the left pane, you should see all note
thumbnails.

JCR=S]

(3) Double click a note thumbnail to view it in full screen. You can click the
button to zoom in or out the view.

15
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Using your Pen in Mouse Mode
In Mouse mode, your Digital pen behaves as a mouse, having the following
functionality:

e To move your mouse cursor you can hover with the pen.

To start Hovering you can press the side button or tip the pen on the paper.
The pen will now hover even with no press for about 30 seconds.

e To Click an object, point your mouse cursor on that object. Now tip the pen
on the paper or click the side button.

e To Double-Click an object, point your mouse cursor on that object. Now tip
the pen twice on the paper or click the side button twice.

e To Right-Click an object, point your mouse cursor on that object. Now press
the tip of the pen a bit longer on the paper. A special ‘Right Click’ cursor will
appear. Lift the pen from the paper, and the context menu (Right Click menu)
appears.

Avoid interference while using regular mouse:

When the pen is not in use it powers off automatically after “
60 minutes. et A

It is recommend that while not in use, the pen is placed as
shown, to avoid interface with a regular mouse operation.

The Note Manager

The Note Manager can be used for storing, viewing, searching, copying and exporting
notes.

It is set up in Windows Explorer format, which allows you to browse through your files
in the left pane and view them in the right pane.

16
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Note Manager Menus

Use these menus to select options and preferences and to perform all software
functions relating to storage and transfer of your notes.

The following table contains a list of all menus and menu commands in the system
together with a short description of their function.

File Menu

Upload Upload Notes from the Mobile unit to the PC

Note To Text Convert handwritten note to texts (only available in
Windows Vista or 7 OS).

Convert To Text Convert your note to Text using MyScript® Notes.
(Only available if the recognition software is installed.)

Join Notes Join several notes together.

Move to Allows you to move the selected note to another folder

Send To Sends any note by email (Jpeg or Data file) or local
network

Import Import data file (.pegvf format)

Export Exports the selected note/s to a JPEG file or a data file
format

Set Reminder Enables you to set an exact date and time that a selected
note will be displayed as a reminder

Show as Sticky Note Make this Note a Sticky Note

Show As Paper Holder Make this Note as Paper holder

Properties View Note Properties

New Folder Create a new folder

Empty Deleted Items Performs a final irreversible deletion of all deleted notes

Print Prints the selected note/notes

Print Preview Displays the selected note as it will look when printed

Print Setup Allows you to select print options

Backup/Restore Backup/Restore your Notes Database

17



Exit Exits the Note Manager interface

Edit Menu

Edit Note Allows you to edit a selected note

Cut Cuts the selected note and saves it to the clipboard

Copy Copies the selected note and saves it to the clipboard

Paste Pastes whatever was last copied or cut to the clipboard

Delete Deletes the selected note/notes

Rename Allows you to rename the selected note

Find Note Lets you search through saved notes based on defined
criteria

Find Next Locates the next note that matches the search criteria

Select All Selects all notes

View Menu

Sort Sort Notes by Date or Name

Small Thumbnails

Displays small thumbnails in the Note Manager view

Medium Thumbnails

Displays medium sized thumbnails in the Note Manager
view

Large Thumbnails

Displays large thumbnails in the Note Manager view

Zoom In

Enlarges the thumbnail view by 50% (available only when
viewing an individual note thumbnail)

Zoom to Fit Returns the thumbnail view size to the original size
(available only when viewing an individual note thumbnail)
Zoom Out Reduces the thumbnail view by 50% (available only when

viewing an individual note thumbnail)

Configuration Menu

Detect Hardware

Allows you to detect your unit

Preferences Allows you to select your personal preference for
elements such as; note color, auto-save, windows options
and printing options

Pen Styles Lets you select the default ink color and stroke width of

the pen

Set Device Orientation

Set your device position on paper (Top center, Left or
Right corners).

Set digital note mode

Select default Pen mode (Mouse/Note)

Mouse Properties

Mouse resolution

Help Menu

Read User Manual

Opens the pocket pen tablet User Manual

About NoteTaker

Displays pocket pen tablet version information

18




Note Manager Toolbox
The Note Manager Toolbox contains buttons that give you access to the most
commonly used menu commands.

Fa + $BEX & M8 |BEE LT ?

The following table contains a list of each button in the toolbox together with a
description of its function.

Button Description
UPLOAD — When in Connected Mode, you can upload all your notes

from the mobile unit to your PC using the Pocket pen tablet software
application

Note To Text - Convert handwritten note to texts. (only
available in Windows Vista or 7)

a Convert your note to text using MyScript® Notes. (Only available if
the recognition software is installed.)
clﬁl:- CUT — Cuts the selected note and saves it to the clipboard
COPY — Copies the selected note and saves it to the clipboard

PASTE — Pastes whatever was last copied or cut to the clipboard

DELETE — Deletes the selected note/notes

EDIT NOTE — Allows you to edit a selected note

PRINT -- Prints the selected note/notes

SHOW AS STICKY NOTE — Make your Note as Sticky Note

SHOW AS PAPER HOLDER — Make your Note as a paper holder

— SMALL THUMB - Displays small thumbnails in the Note Manager
view

II; MEDIUM THUMB - Displays medium sized of thumbnails in the Note
Manager view

El LARGE THUMB - Displays large thumbnails in the Note Manager

view

19




-wf NOTE MODE

L&) MOUSE MODE - TURNS YOUR PEN INTO A MOUSE
ﬂ@ ABOUT - Provides you with your Pocket pen tablet version
information

Creating Notes

The moment you begin to write or sketch with your digital pen, a Note Window
appears on your screen that reflects everything that you write on the paper attached
to the base unit. The Note Window toolbar allows you to perform various basic
functions such as saving, editing, sending and copying your notes while writing, or
once you have finished writing.

NOTE: While writing, make sure not to block the line of sight between the pen and the
base unit with your hand. When the line of sight is blocked, the Pocket pen tablet will
not function properly.

The Notes Toolbar

The following table contains all buttons available in the Notes toolbar together with a
description of their functions.

20



Button | Description
EDIT — Opens the Note Editor for editing the note
) CLEAR - Clears the entire on-screen note.
K UNDO - Clears the previous stroke made by the digital Pen in
reverse chronological order.
Cul REDO - Replaces previously undone strokes in chronological order.
[ 4 PEN STYLES- Changes the Ink color and width.
COPY — Copies the note to the clipboard for pasting into other
applications.
= PRINT — Prints the current note.
= SEND BY NETWORK — Sends the current note by local network to
selected recipients.
| SEND BY EMAIL - Sends the current note by email to selected
recipients as a JPEG attachment.
B2 EXPORT TO JPEG- Exports the selected note to a JPEG file.
= SAVE TO FOLDER - Saves the note to a specified folder and
closes the note window.
{ Convert your note to Text using MyScript® Notes.
(Only available if the recognition software is installed.)
W CLOSE WITHOUT SAVING - Closes the current note without
e saving.
i SAVE AND CLOSE - Closes the current note and saves it into the
o Notes Manager under the default Miscellaneous folder (the note is
named according to the creation date).

Writing notes or Make Drawings
With the device connected, pick up the pen to write or draw.

21
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During writing or drawing, you can use the toolbar to edit, cancel, erase, copy or send
the notes. When finished, click " to exit from the Note Window.

Saving Notes

Notes can be saved at any time during the note creation process. They are
automatically saved to the default and named according to the date they were created.
Notes can be renamed at any time once they have been saved.

To save a note,

(1) Inthe Note Window Toolbar, click the Save and Close icon 2 to save the
note to the default Miscellaneous folder.

(2) Click the Save the Folder icon = to save the note to any folder you select.
NOTE: It is also possible to configure an 'Auto-Save' feature. That will automatically
save your note periodically while you are working.
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Manage Notes
The Note Manager in installed with predefined folders, Miscellaneous, Deleted Items,
Contacts, Follow Up, Received Notes and Mobile Notes.
You can use these folders for storing your notes and can create additional custom
folders, as needed.

Miscellaneous: User-defined Folder

Deleted Items: Store deleted notes

Received Notes: Store received notes by e-mail.

Mobile Notes: Store uploaded notes from the base unit.

Imported Notes: Store imported notes from computer.

Follow up: Store to-be-continued notes

Contacts: Store contact information.

Creating a new folder

To create a new folder:

Creating a new folder can be done in few ways:

You can use ‘File’ menu to run the ‘New Folder* option

(1) Choose the folder you want to create a sub folder for or choose the ‘My Notes’
root folder

(2) Use ‘File’ menu to run the ‘New Folder ‘option.

New Folder x|

Enter a new narne;

(3) Fill the new folder name.

You can right click any folder in the Folders Tree

(1) Choose the folder you want to create a sub folder for or choose
the ‘My Notes’ root folder.

(2) Right click this folder.

(3) Choose ‘New Folder’ from the drop down menu.

(4) A new folder will be created.

(5) To rename this folder please see ‘Renaming a folder’

Renaming a folder

All folders can be renamed except for the predefined Miscellaneous, Deleted Items,
Received Notes and Mobile Notes.

To rename an existing folder:
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(1) Right-click the folder you want to rename (Or press F2 key, when the folder is
selected).

(2) Inthe short-cut menu, select Rename. The folder name is now highlighted.

(3) Type the new folder name.

Deleting a folder

All folders can be deleted except for the predefined

Miscellaneous, Deleted Items, Received Notes and Mobile Notes

To delete a folder,

(1) Right-click the folder you want to delete (Or press the delete button, when the
folder is selected).

(2) Inthe shortcut menu that appears, select Delete.

(3) Select ‘Yes’ to confirm that you would like to delete the folder, or ‘No’ to cancel
the operation.

Renaming Notes

Each time you create and save a new note, it is automatically given a name that

corresponds to the exact date and time the note was created. You can rename notes

at any time to give them names that are more meaningful to you.

To rename a note:

(1) Right-click the note you want to rename (Or click F2 key, when the note is
selected).

(2) Inthe shortcut menu that appears, select Rename. The note hame is highlighted.

(3) Type the new note name.

Join Notes
You can join more than one note together.
(1) Select more than one note together by dragging the mouse.
(2) Right click the selected notes and then select “Join Note” from the menu.
(3) Enter the new name for the joined note and press Confirm. The selected notes
are joined into one note with the new name.
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(joint note)

Moving Notes

You can move a note from the folder it is currently in to any other folder.
To move a note to another folder:

(1) Inthe Note Manager, select the note file name or thumbnail.
(2) From the File menu, select Move to,

—or—

right-click the note name or thumbnail and in the shortcut menu, select Move to
(3) Select the folder name to which you would like to move the note

NOTE: You can also use ‘Drag and Drop’ to move a note.

Finding Notes

It is possible to search through your saved notes to locate any particular note.
In order to perform a search:

(1) In the Notes Manager Edit menu, select Find Note.
(2) Select the folder or folders where you would like to search.
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(3) If you would like to search by description or note name, select by description and
then in the search for field, type in the name or description of the note you are
looking for.

(4) To search by creation date parameters, select All notes created and then specify
the date range according to which you would like to search.

(5) Click Find.

x
Lok in folder: |My Mates j

& by description

Search for: Il

= Al notes created:
¥ Between Joasosizaor =] e [odss2007 x|
€ During the last I'I =il days.
£ During the last I-I 3: i ezl |

Printing Notes
A note can be printed from any of the 3 Note interfaces — The Note Window, The Note
Editor or the Note Manager. Notes can be printed from a saved file in the Note
Manager, or while they are open in the Notes Window or Notes Editor.
To print a note from a file,
(1) Inthe Note Manager, click the note name or thumbnail.
(2) In the File menu, select Print Preview to first see how the note will

look when printed.
Note: You can preview multiple notes simultaneously. Select the first note, then on
the keyboard press the <CTRL> key and select the other notes.

(1) In the File menu, select Print or click the Print button S :

(2) Select your desired print setting and properties (this can also be done through
Print Setup from the File menu. Some default print preferences can also be set
through the Configuration menu preferences).

(3) Click OK.
Print EE'

P

ore PN =] Froveie:
Satus Fetuachy

T P Laseel st 4000 Sa6as POL

Whers:  VHASTERHP

Comment
Prink L Copiss
& My ol opees 1 =N

™ Prrt o e ¥ Center On Pags I
oK Cancel
Mis peif age —I =

To print an open note,
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(1) In the Notes Editor File menu, select Print or click the Print button =
—or—
in the Note Window toolbar, simply click the Print button.

(2) Repeat steps 4 and 5 in the previous procedure.

Backup and Restore Notes Database

You can use the Note Manager to backup your entire database, and restore it when

needed.

To backup your database:

(1) Select ‘File -->Backup/Restore --> Backup Database’ from the Note Manager
menu, the following dialog will appear.

Browse For Folder x|
Select a folder to backup database into,
rE| Contacks =
'D Deskkop
= T Documents
. Lab¥IEW Data
. My Maokes

. My Received Files
5 My Shapes
. Motes
. Updater
. Wisual Studio 2005 =

Make MNew Folder | Backup I Cancel |

4

(2) Choose the destination path to backup all your notes database
(You can create a new folder by pressing ‘Make New Folder’ button)

(3) Click the ‘Backup’ button, Upon a successful backup, the following message
appears:

NoteTaker =l

'0' Database has been backed up successfully.

To restore your database:
(1) Select ‘File -->Backup/Restore --> Restore Database’ from the Note Manager

menu, the following dialog will appear.
]

Gelact & Fokder containing the database to Be restoned.

[ Ceshiop

Rl et
) Publc

N Compater
7 ¥ hstwork

ez
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(2) Choose the location of your database backup]

(3) Click the ‘Restore’ button.

(4) Upon a successful restore, your database will be restores to a new folder in the
Note Manager. This new folder will be nhamed ‘Restored database’ and will also

be according to the restoring date and time.
Y i Mg [ -1, ]

M DN e Cpigason e

e | & A EEE T

Py Pt

M sbirens =
4 Dmimtad [r=s ]
4 [T —
= E T « 1A

o sl Fowaa P

Setting Your Preferences

Set your default preferences such as note color, auto-save options, print preferences,

etc. in the Preferences dialog box.

The dialog box is divided into three tabs, each controlling a different aspect of the

system: General, Printing, and Ink.

To access Preferences:

(1) Inthe Notes Manager Configuration menu,

select Preferences.
(2) Setyour General Preferences as follows:
¢ In the Auto-Save note in box, select the time e F =] s
interval (in minutes) after which the system P lzsd whem wirgrun o)
automatically saves your note. This also
activates an auto-recovery feature that
recovers any unsaved information in case of
system crash or power failure. The only lost
inputs are changes made since the last auto-
save.
e Select the Load When Windows Starts checkbox to automatically load the

Pocket pen tablet each time you turn on your computer, so that a new note will
pop up whenever you begin to using the Pen

Preferences Ed

£ Beneral | & Mot | @ Prrtens| £2) Pages Hos

[3 Cocel | Ho |
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e Select the Save Sticky Notes on Exit checkbox to automatically save all the
new sticky notes you created. The saved sticky notes will then instantly appear
the next time you either turn on your computer or restart the application

Set your Mobile Preferences as follows:
e Select the Upload new notes automatically proper
option.

Prelreines =)

5 Goroel <F oo | @ Punting | 4] Pager Heade |
wih pirresirg s Mok e
Wbl e i sbomote sl
g
= Fig
Ak e

ok ] toed | Hee |
Freleremes x|
Set your Print Preferences as follows: 5 G| 2 ot &8 P | 2] ages Hek
e Select the Note Per Page checkbox to specify that """'ZMW
when you print notes, only one note is printed per P
page
e Select the Center Note On Page checkbox to
specify that notes always be centered on the page
when printed
e ] i | v |
Frelrremes x|
Set your Paper Holder Preferences as follows: e s o
e Under Paper Holder opacity, drag the slider to set B
the desired level of transparency = o
[ =
Selecting Pen Style
You can change Ink color and width of on-screen pen strokes at any time
(The default pen color is black and the default width is 1)
To select the pen style:
In the Notes Manager Configuration menu, select Pen Styles

Right-click the new note and in the shortcut menu
that appears, select Pen Styles
(1) Click the arrow to the right of the current pen

Pen Styles |

Pen Colar: ] |v|
Cancel
Per "Width: I‘I _l::l 4I

Default |
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color to open the Pen Color list and select the color you want.

(2) Use the arrows to the right of the current pen color width to select a pen stroke
width between 1-10 (you can also type the desired width directly in the box)

(3) Click Default in order to restore the default settings at any time

(4) Click Cancel to return to the Note Manager or to the note without changing the
current pen style settings

NOTE:

You can also change the color and width of any pen stroke in the Note Editor by
selecting an individual pen stroke or group of strokes and then in the Tools Menu
selecting Color or Line Width.

Setting a Reminder

You can use notes stored on your PC to be reminders by setting an exact date and

time for a selected note to automatically pop up on your screen.

To set a Reminder:

(1) Inthe Note Manager, select the note or note thumbnail In the File menu, select
Set Reminder —or— Right-click the note and , in the shortcut menu, select Set
Reminder.

(2) Select the Enable Reminder checkbox

(3) Inthe Remind On list, click the arrow to the right of the list and select a date from
the drop down calendar that appear

(4) If you would like to specify an exact time for the reminder, select the Exactly At
checkbox and use the arrows to change the default time or type in the desired
time.

NOTE: If you do not select an exact time, the reminder will appear when you turn on

your computer on the specified day.

[V Enable Beminder
Remind Or: [ Thusdsy . apil 05,2007 | L = ﬂ
Exactly AL m
Meot Fromk
ot [4:e0 rr\-.
[ ok | cancel Help oK Snooze |

Setting a Reminder to Snooze
When a reminder appears, you can set it to snooze so that it disappears and then
pops up again within 5, 10, 15 or 20 minutes (depending on your preference).
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To set a reminder to snooze

(1) Click Snooze.

(2) In the drop-down list, select the number of minutes you want to “snooze” until
you're reminded again.

B 00 MEE

M eet F"“’“h
at H:wrm.

|T| Snnoze‘
5 Mirates
10 Minutes

15 Minutes
20 Minutes

Exporting to JPEG

You can export any note to JPEG file format, turning the note into a graphic image.

This is useful for example when you want to insert notes into documents created in

other applications such as MS Word or PowerPoint.

To export a note to jpeg format:

(1) Inthe Note Manager, select the note you want to export.

(2) Right-click the note name,
—or—
in the File menu, select Export to JPEG. The
Export dialog box appears.

(3) In Save in, select the destination file path

(4) Inthe Save as type list, select JPEG.

(5) Under Resolution, select the resolution
quality

(6) Click Save

NOTE: You can export multiple notes simultaneously. On the keyboard, hold down
the <CTRL> key and then in the Note Manager, select the notes you want to export.

B et e e e ——
L e @ =
Exporting to a Data format file | 2
You can export any note to a vector format file, | LSt ,'i::.-';'.' =
so that another Pocket pen tablet user can _ s
import this file into the Note Manager database l..
To export a note to a data file (.pegvf file): -
(1) Inthe Note Manager, select the note you T M iUwas =
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want to export.
(2) Right-click the note name,

—or—

in the File menu, select ‘Export as a data file’. The Export dialog box appears.
(3) In Save in, select the destination file path.
(4) Click Save.

Importing a Data format file S E—
You can import any .pegvf Data format file into | . s s
the Note Manager database =

To import a data format file:

(1) Inthe File menu, select ‘Import a data file’.
The Import dialog box appears.

(2) Select the file you would like to import. Maad [hws)  mee s e

Fin of o b et - Laom

(3) Click Open | i

Pasting Notes into Other Applications

You can paste any saved note into another application.

(The note is automatically converted into a JPEG image).

To paste a note into another application:

(1) Inthe Note Manager, select the note or thumbnail.

(2) In the Edit menu, select Copy or Cut (cutting will delete the note from its current
location),
—or—
right-click the note name or thumbnail and, in the shortcut menu, select Copy or
Cut.

(3) Open the application into which you would like to paste the note.

(4) Inthe open application, locate and select the Paste Oﬁtion.

Note: You can also copy a note that you are currently sketching by clicking on the
button in the Note Toolbar
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Creating Sticky Notes

You can create sticky notes by doing one of the following:

(1) Dragging notes from the Note Manager to your desktop.

(2) Select a note in the Note Manager, right click it and select ‘Show as Sticky Note’

|
EL e — x|
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(3) Select a note in the Note Manai er, click the ‘Show as Stick‘ Note’ toolbar button
£ Hota Manager
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NOTES:
To view additional sticky note options,
(1) Right click on the sticky note.

Convert To Text

Frint...
Color »

Hide:
Close

(2) Select ‘HIDE’ to hide a sticky note into the application tray icon
(3) You can restore any hidden sticky note by right clicking the application tray icon,
and selecting ‘My Sticky Notes’. Then select the note you would like to restore.
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Detect Hardware, ..
Upload My Mabile Maotes, .

? about MokeTaker..,
Exit

(4) A Sticky Note can automatically pop up after the application has been closed
and re-opened, or after system reset. In the Note Manager, use the

Configuration menu
Prelerences =]

B Geoarsl |8 Porting | £2] Paper Hokder

Bute-Sarem rote n 5 B rwrubes
| Lol whiers Wirhoow abacta

T ’mrsoq'nﬁﬂméﬁ'

Ok Cancal Halgy

Creating Paper holder Notes
Paper holder notes can help you in many ways.
One common way is if you need to read your note and rewrite it in a
text editor.
A paper holder note will always be on top, and its transparency can
be adjusted
You can create paper holder note by doing one of the following:
e Select a note in the Note Manager, right click it and select
‘Show as Paper Holder'.
e Select a note in the Note Manager, click the ‘Show as Paper
Holder’ toolbar button
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NOTES:

You can hide and show paper holder notes the same way you hide and show sticky

note.

To view additional options, right click on the sticky note
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You can set the transparency to a Paper Holder.

In the Note Manager, use the Configuration menu

Generall iwd Mobilel & Fiinting PaperHoldell

The Note Editor

— Opacity

Paper holder opacity:

Transparent | |— : Opague

a0%

QK I Cancel Help

Notes can be edited at any time, whether you are still writing one, or you want to edit
a note you have already saved in the Note Manager. The Note Editor contains menus
and a toolbar that give you access to a wide selection of editing functions
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35



Note Editor Menus
The following table lists all menu commands available in the Note Editor, together with
a description.

Note menu

Print Prints the selected note

Print preview Displays the selected note as it will look when printed

Print setup Allows you to select print options

Exit & Save/Send Saves the edited note and closes the editing

EXIT Without Closes the editing application without saving any changes

Save/Send

Edit Menu

Undo Clears the last stroke made by the digital Pen. Clicking
Undo again will clear the stroke made before that, and so
forth.

Redo Replaces previously undone strokes in chronological order

Cut Cuts the selected note and saves it to the clipboard

Copy Copies the selected note and saves it to the clipboard

Paste Pastes whatever was last saved to the clipboard

Delete Deletes the selected note

Clear Note Clears the entire on-screen note

Select All Selects all the pen strokes in the note

View menu

Zoom In Increases the note view

Zoom to fit Restores the note view to the original size

Zoom Out Reduces the note view

Toolbars Allows you to select which editing toolbars you want to view
(Standard, Tools, Manager)

Status bar Allows you to view or hide the status bar at the bottom of
the Notes Editor

Full screen Opens the Notes Editor into full screen view

Configuration menu

Pen/Highlight Lets you select the color and width of the Editor Pen and

Properties Highlighter

Tools menu

Selector Allows you to select any area by clicking and dragging with
your mouse
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Pen Allows you to freestyle draw with your mouse

Highlight Allows you to highlight any area by freestyle drawing with
your mouse

Line Allows you to insert a line of any length

Circle Allows you to insert a circle image of any size

Rectangle Allows you to insert a rectangle of any size

Text Allows you to insert type written text

Color Allows you to pre-select or change the color of pen strokes
or to highlight strokes or text

Line Width 1 Allows you to pre-select or change the thickness of any
stroke to width 1

Line Width 2 Allows you to pre-select or change the thickness of any
stroke to width 2

Line Width 4 Allows you to pre-select or change the thickness of any
stroke to width 4

Line Width 8 Allows you to pre-select or change the thickness of any

stroke to width 8

Help menu

Read User Manual Review the user manual

Check for Software | To get software update programs
Updates

About NoteTaker Displays software version information

Note Editor Toolbars

The Note Editor Toolbars provide you with quick access to the more common menu
commands.

The following table lists all toolbar buttons, together with a description of their
functions.

Standard Toolbar
= PRINT -- Prints the selected note
.;'H': CUT — Cuts the selected note and saves it to the clipboard
COPY — Copies the selected note and saves it to the clipboard
E PASTE — Pastes whatever was last saved to the clipboard
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ABOUT POCKET PEN TABLET — Provides you with your Pocket
pen tablet version information

FULL SCREEN - Brings the Notes Editor into full screen view

NOTE COLOR — Changes the current note color.

Tools toolbar

SELECT — Allows you to select any area by clicking and dragging
with your mouse

PEN — Allows you to freestyle draw using your mouse

HIGHLIGHT — Allows you to highlight any area by freestyle
drawing using your mouse

LINE — Allows you to insert a line of any length

CIRCLE - Allows you to insert a circle image of any size

RECTANGLE — Allows you to insert a rectangle of any size

= O O] 2

TEXT — Allows you to insert type written text

COLOR - Allows you to pre-select or change the color of pen
strokes or to highlight strokes or text

LINE WIDTH 1 — Allows you to pre-select or change the thickness
of any stroke to width 1

LINE WIDTH 2 — Allows you to pre-select or change the thickness
of any stroke to width 2

LINE WIDTH 4 — Allows you to pre-select or change the thickness
of any stroke to width 4

LINE WIDTH 8 — Allows you to pre-select or change the thickness
of any stroke to width 8

Manager toolbar

£F CLEAR PAGE — Clears the entire on-screen note
K7 UNDO- Clears the previous action
Tl REDO- Replaces previously undone action
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ZOOM IN - Enlarges the note view

ZOOM TO FIT - Returns the note view to the original size

ZOOM OUT — Reduces the note view

ROTATE RIGHT — Rotates the entire note image 90° to the right

G|l el 0 W

ROTATE LEFT — Rotates the entire note image 90° to the left

Editing Notes

Once a note is open in the Note Editor, you can only edit elements of the note (pen
strokes, etc.) after they have been selected. Once you have selected the area you
want to edit, you can delete it, change the color and/or width of the pen strokes, etc.
You can also add figures and drawings into the note using the various drawing
features (insert circle, line, highlight, text, etc). These new elements can also be
edited after you insert them.

To start editing a note,

(1) While working on a note, or in the Note Manager select the note and click the

Edit Note button | = :
—Or-—
right-click the note and, in the shortcut menu, click Edit Note.
-Or-
(2) Double click a note in the note view mode.
(3) The Note Editor window opens displaying the selected note.

(4) Use the Select Area button b in the Tools Toolbar or the Select option from
the Tools Menu to select a particular stroke or group of strokes,

in the Edit menu, click Select All to select the entire note.
(5) Use the edit toolbar to edit the strokes.

NOTE: While editing, you can still use your pen to continue sketching on the note.
Sending Notes
You can send any note by email or over the local network. An emailed note appears

as a JPEG attachment to the recipient. In order to send a note by local network, the
recipient must have the Pocket pen tablet software installed and running on his/her
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PC. Notes can be sent by email or network from both the Note window and the Note
Manager.

Sending notes by email
The Pocket pen tablet uses your default email client to send notes as email.
To send a note immediately after you have completed it:

(1)
(@)
3)

(4)

Click the Send Note by Email button ]

A new email form opens with the note in the form of a JPEG attachment

Type in the desired recipient’'s email address and any desired text in the subject
and body of the email

Send the email

To send a saved note:
Any saved note can be send as a JPEG or vector format file

o
0]

In the Note Manager, click the note name or thumbnail.

In the File menu, select Send TO --> Email,

—or—

right-click the note name or thumbnail and, in the shortcut menu that appears,
select Send TO--> E-Mail .

A new email form opens with the note attached as a JPEG file.

Type the desired recipient’s email address and any desired text in the subject
and body of the email

Send the email

Sending notes over the local network
To send a note immediately after you have completed it,

(1)

(@)

3)

In the Note Window, click the Send Note to

x

l"'El Send naote ta :
Network PC button "% =, | Qe |
In the Send Note dialog box, a list of all Nre [Bdgess |
network users that have the Pocket pen i e _ et |
tablet application installed and running s 1onnrar okttt |
automatically appears. Select the Name/IP = nane
address of the person(s) to whom you would |
like to send the note
click Select All to send the note to everyone on the list.
Click Send.

To send a saved note:



o Inthe Note Manager, click the note name or thumbnail.

o0 Inthe File menu, select Send To--> Network PC,
—or—
right-click the note name or thumbnail and, in the shortcut menu that appears,
select Send To --> Network PC.

o Inthe Send Note dialog box, a list of all network users that have the Pocket
pen tablet application installed and running automatically appears. Select the
Name/IP address of the person(s) to whom you would like to send the note
—or—
click Select All to send the note to everyone on the list.

o Click Send

NOTE: You can select multiple recipients when sending a note via local network By
selecting a name in the list, then pressing <CTRL> On the keyboard and selecting
another name or names.

Receiving notes over the local network

Users on a local area network (LAN) such as may exist in an office environment can
receive notes over the LAN.

When you receive a note, it automatically appears on your PC screen and a sound is
heard.

Edit & Reply

Prink. ..
Save To Folder...

Send To K

Close

o Right click the received note to have the following options:
o] Replying to the sender (this includes an editing function so the user
can add text and sketches)
Printing the note
Saving the note
Setting a reminder
Sending the note to other users on the network
0  Close the Note
Notes received by LAN will be saved under ‘Received Notes’ in the Note Manager.

O O O O
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Convert Note to Text
You can convert your handwritten notes to texts in the following two methods.

Using the “Note to Text” menu (only available in Windows Vista or 7)

(1) Open the Note Manager, select the note that zou want to convert.

(2) Click the “Note to Text” icon from the top tool bar. The note is then
converte to text. Save the converted note as you want.

[ VyTextile - 83 1
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savellviotes

Using the Vision Objects MyScript® Notes (Optional)

MyScript® Notes is a well known character recognition engine. It can covert the
notes in your Pen-Tablet to texts. You can purchase the software from its vendor if
you want.

(1) Installing MyScript® Notes. Follow the installation instructions in the software
manual.

(2) Operating MyScript® Notes. To use the MyScript® Notes recognition engine,
please make sure you have installed Pen-Tablet Software Suite. Then, you can
select a note, Notes, or a Sticky Note, and export them to the MyScript®
Notes recognition engine.

Exportable objects from NoteTaker to MyScript® Notes:
e A New Note

e Asingle Note from “NoteTaker Manager”

e Multi pages Note from “NoteTaker Manager”

e Sticky Note from “NoteTaker Manager”

(3) Exporting objects. Use the following methods for each type of object in order to
export it to MyScript® .

a. For a New Note, Click the “Convert to Text” toolbar button .
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b. For A single/multi page Note from “NoteTaker Manager”, right click the Note

in the thumbnails area.
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c. Right click

d. Select a note and select “File --> Convert to Text” menu.
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e. For sticky Note from ‘NoteTaker Manager’, right click the “Sticky Note” and

select “Convert to Text” menu.
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Convert To Texk
}/} f M PFir...
Calor 3

Hide
Close
(4) Your Note will be exported to MyScript® Notes application. MyScript® Notes
will be opened with your Note in the “Conversion” area. Please refer to the
MyScript® Notes user guide for more instructions on how to use the
MyScript® Notes application.

Application Tray Icon

Right clicking the application tray icon gives you the ability to perform the following
actions:

Browse Notes — Open the Note Manger

Browse MNotes
Mote Mode

Detect Hardware...

About MoteTaker...
i Exit
Note Mode “-** Or Mouse mode E — Toggle between the 2 options of your
Digital Pen. Tray icon changes accordingly
Detect Hardware - Detect your hardware. If your hardware is not detected, the tray

icon changes to 'ﬁ
Upload My Mobile Notes - Upload your Notes from the Pocket pen tablet. the tray

icon changesto
About Pocket pen tablet - See application details (About Dialog)
Exit - Exit the application

Chapter 5 Use Pen Tablet in Windows Vista

The rich inking features & utilities in Window Vista enable users to take handwritten
notes, convert handwriting to text, annotate documents, add electronic signatures and
send handwritten emails.
With integrated Pen-Tablet support, digital ink technologies and handwriting
recognition technologies your Pen-tablet turns into a Table PC compatible device

that's practical, comfortable, intuitive and easy to use while you are on the go and it
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also works well when you are at your desk..

This chapter provides basic instructions how to utilize inking and handwriting utilities
in Windows Vista and Office 2007’s applications. For more features and possibilities
please refer to Microsoft’'s User manual and Help.

* Pen-Ink capabilities are NOT available in Windows Vista Basic.

Getting started

To start inking in windows Vista, just plug-in your Pen-Tablet to any available USB
port, place the receiver unit at the top of the page in the middle. You are ready to go.
No further installation is required to use all Windows Vista and Office 2007
applications.

Pen-Tablet can serve you as handwriting
instrument as well as pointing device - a mouse.

Note: Make sure your Pen-Tablet is in Mouse
mode.

Windows Journal
Windows Journal looks like a sheet of paper but it is far more flexible than a typical
pad of paper. You can change pens, pen colors, highlighters and erasers, move items
around on the page, make space for additional items, send the notes as email,
convert handwriting to text and enjoy many more features. All of that is done by just
using Pen-Tablet for handwriting and mouse functionalities.

To start Windows Journal:

Click Start button e, type Windows Journal in the search box, and then tap
Windows Journal in the list of results. Alternatively, you can click Start = All

Programs — Windows Journal.

EEEEEEN da EEEE =
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Conversion to text and conversion to email:

Use the Lasso to mark the conversion area. Tap Actions and choose Convert
Selection to E-mail or Convert Selection to text (if a character recognition application
is installed.)
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Tablet PC Input Panel

In Windows Vista, the Tablet PC Input Panel is the standard interface for converting
handwriting to text in a Windows-based program. It's the method by which Pen-Tablet
users enter text into applications that do not include a custom handwriting interface.
Using Input Panel, users can insert text into website forms, word processing and e-
mail applications, web browsers, and more.

The Three Input Areas of Input Panel:

The input Panel includes three input areas for entering text: the writing pad, the
character pad, and the on-screen keyboard. The writing pad and the character pad
convert handwriting into typed text. The on-screen keyboard works just like a standard
keyboard except that the user enters text by tapping keys with a Pen-Tablet.

The following illustrations show the writing pad, the character pad, and the on-screen
keyboard.

— P )

ﬁé deted p.  Bromsde avcl ek &

Vo | | et | || e || w8

To improve personal handwriting recognition, go to Tools and tap Personalize
Handwriting Recognition.
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There are three ways to open Input Panel:

1. Tap the Input Panel icon, which appears
when you place the pointer in a text entry

area, such as the Address bar in a web
browser or a text box in a dialog box.

2. Tap the Input Panel tab, which appears ¢
by default on the left edge of the screen. ‘
When you open Input Panel this way, it
floats on top of any open windows.

3. Tapthe Tablet PC Input Panel icon on
the Windows taskbar. The Input Panel
icon does not appear on the taskbar by
default. To make it appear, right-click the
taskbar, tap Toolbars, and then tap
Tablet PC Input Panel.

Sticky Notes
Write down ideas and thoughts in a quick and easy way using desktop notes
(“stickies™).

7/30/2007 1:39 PM ___I __la‘
Tools  Help b 3f3 %] Q@

Cotl Bob crd chek

310-745 G2/0

> = \_?, — Hew Note |

<=l

Keep your information, quick notes, addresses, phone numbers, web links and more
in one place where you can easily find it? Windows Vista can offer you different
electronic notes software and freeware solutions that allows you to quickly write
something down any time you need - during a meeting, lecture, searching information
on the Internet, etc.
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To make sticky notes open automatically at startup go to Tools, tap Options and then
tap Open at Startup.

Open Sticky Notes by tapping the Start@ button, typing Sticky Notes in the
search box, and then tapping Sticky Notes in the list of results.

Alternatively: Start — All Programs — Sticky Notes

To keep sticky notes always visible on the desktop Tap the Tools menu, points to
Options and then type Always on Top.

Note: Your notes are automatically saved when you close Sticky Notes

Windows Snipping Tool

The program is a screen-capture tool that allows taking screenshots (called snips) of
windows, rectangular areas, or a free-form area. Snips can then be annotated, saved
(as an image file or HTML page), or e-mailed.

Open Snipping Tool by tapping the Start button, typing Snipping Tool or just
Snipping in the search box, and then tapping Snipping Tool in the list of results.
Alternatively: Start — All Programs — Snipping Tool

The first time you use the Snipping Tool, you will be provided an option to add it to
your quick launch bar.

e == ——— ——

Pen-and-Ink functionality in Vista- Office 2007
Microsoft Office 2007 and a Tablet-Pen offer new capabilities that allow you to work
more naturally and efficiently. Within Office 2007, numerous applications support
digital mark-up with Tablet-Pen and provide easy access to digital inking tools for
intuitive collaboration in:

e Word

° Excel

o Outlook
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PowerPoint
° OneNote

Writing with a pen is a particularly efficient and natural way to comment on an existing
document and to capture rough thoughts that are emerging in real time.

Word, PowerPoint and Excel have a Review tab with a Start Inking button that
provides an Ink Tools menu. This menu includes tools such as: felt tip pen,
ballpoint pen, highlighter, and eraser, as well as options to select the Ink Color.

Mailings Review View Pens
Z nk Comment | [=E =N 2% Final showing Marku - \s 5} Reject - = i :
Gl g P R ] 3 -
7y B [N £z
o Ber - 2 show Markup ~ ' 2 Previous —
: Track Balloons o Accept Compare Show Soufce Protect Start
Sl Changes ~ - Bl Reviewing Pane - - 22 Next - Documet Document || Inking
its Tracking Changes Campare Protect Ink
%v == 25: W
Ink Tools
_'_J:/ Home Insert Page Layout References Mailings Review View

s> 24l 7/ |0 L= B

Select Delete | Ballpoint |Felt Tip |Highlighter | Eraser Color Weight || Close Ink

Objects all Ink Pen Pen Tools
Select Pens Farmat Close
d92-04 Bk /BLZEDg-=-D|s ¢

Quick Access Toolbar
The Ink Tools allow you to markup and edit documents in a natural way. In Word,
easily mark-up copy and make noticeable edits.
To create Quick Toolbar, please follow the instructions below:

1. Place the cursor on the bar next to View and right click the mouse. Tap
Customize Quick Access toolbar.

Word Options

Popular "; Customize the Quick Access Toolbar and keyboard shortcuts.
Display

Choose commands from: Customize Quick Access Toolbar:
froofing

- ink Tools | Pens Tab For all documents [default) b

D
Typography <Separators i Seve

Z  pallpoint Pen = Undo ¥
ARHEREE B Close ink Took 0 Redo
Customize Close Ink Tooks #  Ink Comment

Ny Delete All Ik # Ink Cormmant Eraser
Add-ins '  Eraser #  start Inking
Trust Cent # pelt Tip Pen v Show ink

Format - # Pen

Resources #  Highlighter B Ciose Ink Tasls

s 'nk Colar 5 » Eraser

% More Ink Colars u #  Highlighter

Mora Lines. - #  galipoint Pen
= Cutline Weight L] 3 Delete All nk

2. Choose Ink Tools Pens Tab by taping the arrow at Choose command
from (see yellow highlight)
3. Add ink and pen icons at your will by using Add button
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Selected examples for using digital ink in Office 2007 Applications

Signatures, Ink Comments and annotation in Word 2007
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Inking Excel 2007

& 25'._3;\} 2= .

= o . e )

] : e i ¥ ] W T : . 1 1 - 2]

" Noah's Premium lce Cream Sales

.. Oak Street Store

" May-05

.II i mes Beowsus - =3
= = " .
v = :

P = [

B ey ey | man == F

= == _ 7

: i e [

2o o

i = - = /

= & — -

s e e

- eH o

2 = l&g

- ey R

" B My sk

- I ey B |

o mm ez

Lomm s

e s 2

B[ e A

« | [L7e= | [sewdomasicom
Sendl | |
accout = | | mee. |

Subject: | Haw to pet 1o our office

chi-o?zl‘ yPeea
Seleel.
L_eﬂf_’_ﬂ!__-ﬂl—

=

50



Drawing in on-line messenger
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For more information about the various available options of using Pen-Tablet, inking
and handwriting, please refer to Microsoft manuals and Help service.

Chapter 6 Using in Mac OS

Installing the Note Manager for Mac software

The following procedure guides you through installation of the Note Manager for

Mac.

1. Click on the NoteTaker installer icon (NoteTaker. pkg). The NoteTaker Installer
opens (a standard Mac installer):

L Rata) o Inusadl P MoteTakes

Welcome 1o the Pegasus NoteTaker Instalier

o introduction |
You will be guided hiough the Weps recriiany tn
inieall ehin scfiware

Ceettinug

Figure 1: NoteTaker Installer
2. Click Continue. The Installer advances to the Destination Selection step. In this
step, you are asked to choose the location (usually your Mac hard drive) where
you want to install the Note Manager software. When you select (click on) your
preferred hard drive, the Installer confirms your selection:
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Figure 2 Installer showing the Destination Select stage
3. Click Continue. The Installer advances to the Installation Type stage. In this stage,
you confirm that you want to perform a standard installation of the Note Manager
software on the hard drive you selected.
Notes: Performing a standard installation will install the software directly into your
Applications folder on your Mac’s hard drive.
If you want to change the location to which the software will be installed, clicking
Change Install Location will return you to the previous step, Choose Destination
Location.

4. Click Install. The Password dialog opens.

5. Enter your user password and click OK. The Note Manager software is installed on
the drive you selected and the Install Succeeded message is displayed on the
Installer.

6. Click Close to close the Installer and complete the installation.

Using the NoteTaker Preferences Tool

About the Preferences Tool
When you use your Digital Pen to write text, everything you write is saved as a series
of TIFF (Tagged Image File Format) images in the base memory unit. Before you can
work with your text on your Mac, you first need to transfer the TIFF images from the
Pen-Tablet to your Mac’s hard drive. When you connect the Pen-Tablet to a USB port
on your Mac, your text is automatically transferred directly from the Pen-Tablet to your
Mac.
Before you can start transferring your text from the Pen-Tablet, you first need to set
preferences on your Mac. By setting preferences, you decide:

« Wwhere on your Mac’s hard drive you want to save the TIFF images;

« Wwhether you want to erase the TIFF images from the Pen-Tablet after you have

imported them to your Mac.
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You set these preferences using the NoteTaker Preference Tool.

Setting Preferences with the NoteTaker Preference Tool

The following procedure describes how to set preferences using the NoteTaker

Preference Tool:

1. Click on the NoteTaker Preferences icon. The NoteTaker Preferences dialog
opens:

Target path: | Usens avadeengay 3 Documents 5 Microsoh User Data

W Clear device's ATy

Save Exx

Figure 3: NoteTaker Preferences dialog

The NoteTaker Preferences dialog consists of the following elements:

» The Target Path — displays the path to the location on your Mac’s hard drive where

TIFF images from the Pen-Tablet will be saved.

» The Clear Device Memory checkbox — if this checkbox is checked, the Pen-

Tablet’'s memory will be cleared (erased) after you upload TIFF images to your Mac. If

the checkbox is unchecked, the TIFF images will remain saved on the Pen-Tablet

after you have uploaded them to your Mac.

2. The first preference you need to set is the location on your Mac where TIFF
images will be saved when you transfer them from the Pen-Tablet. The Target
Path displays the default location to which the TIFF images will be saved. To
choose a different path, click the ellipsis button (“...”) to open the Finder window:

o B Migraiadt Unar Duzs % o

1 3 Eetpurag. enu hemt
B firant i Emopurage Temp
B sk Excel Son ani Tens

Difice 2004 Idenines

New Foider Cance Oper |

Figure 4: NoteTaker Preferences Finder window

3. Choose where on your Mac you want to save TIFF images by clicking on the
relevant location in the left hand column, and then click Open. The Finder window
closes and the new Target Path is displayed in the NoteTaker Preferences dialog.

4. If you want to clear the Pen-Tablet’ s memory each time you upload TIFF images
from it, check the Clear Device Memory checkbox. To leave the TIFF images on
the Pen-Tablet after they are uploaded, leave the checkbox unchecked.

5. To save your preferences and close the NoteTaker Preferences dialog, click Save.
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When you next connect the Pen-Tablet to your Mac, your images will be uploaded
according to the preferences you have set.
6. To close the NoteTaker Preferences dialog without saving any changes, click Exit.

Pen-Tablet operation with Mac
1. Use the Pen-Tablet to capture and save your notes while you are away from
your Mac, in meetings or lectures.
2. Connect the Pen-Tablet to your Mac, to upload the saved notes. The notes are
saved in TIFF format. Double click on the desired TIFF file, in order to view the

note.
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3. While being connected to the Mac via the USB port, the Pen-Tablet can be used
as a Mouse and as a Tablet input device for Mac ink applications. Use the digital
pen in applications such as iWork’08. You can write handwritten test, on-line,
and the Mac will convert it into text. The feature is available iWork Pages (word
processor), iWork Keynote (presentations) and iWork Numbers (spreadsheets).

2 ¢ g
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The Digital Pen can be also used for drawings inside applications such as Adobe
lllustrator, Photoshop, etc.

Chapter 8 Taking Care of Your Pocket pen tablet

Storing your Pocket pen tablet

e Keep your Pocket pen tablet away from liquids and direct sunlight at

all times.

e Always store your unit in protected packaging or in the original box.
e Severe shock can cause degradation in performance. Take
precautions not to drop the memory Unit or Pen onto hard surfaces.

Cleaning your Pocket pen tablet
e Clean your Pocket pen tablet using a soft cloth.

e Special care must be taken not to insert sharp pointed objects into the
ultrasonic transmitting and receiving units.

Chapter 9 Troubleshooting

Problem

Possible Cause

Solution

The LCD displays
nothing when | power
on the base unit

Battery of the base
unit is too low

Connect the base unitto a
computer or use the charger
to charge the battery

The battery icon does
not blink during
charging

The charger/USB
cable is not
connected properly

Reconnect the charger or
USB cable

The charger/USB
cable is damaged

Replace the charger or USB
cable with a new one

The pen stroke is
invisible on the screen

The Note Manager
does not run

Run the Note Manager
application provided with the
package

The hardware (pen or
base unit) is not
installed correctly

Re-install the hardware

The pen is in Mouse
mode

1. Press the ON/OFF button
on the base unit to switch to
Pen mode(refer to the user
manual).

2. Set the pen as Pen mode
in Note Manager (refer to
the user manual).
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The distance between
the pen and the base
unit is beyond the
area of A4 paper

Make sure the distance
between the pen and the
base unit is within the area
of A4 paper.

The digital pen's
battery is too low

Replace the pen's battery

The pen stroke is
messy or
discontinuous.

There is barrier
between the pen and
the base unit.

Remove the barrier

Your handhold is so
close to the pen tip
that the transmitting at
the pen tip is blocked
by your finger.

Refer to the user manual for
instruction of correct
handhold

The battery of the pen
Is too low

Replace the battery

Your writing is too
gentle.

Impose more strength on
your writing.

The writing surface is
not smooth or the
paper is not spread
well.

Make the writing surface is
smooth

The mouse is dead

The pen's battery is
too low

Replace the battery

The penis notin
Mouse mode

1.Press the ON/OFF button
on the base unit to switch to
the Mouse mode.(refer to
the user manual)

2.Set the pen as Mouse
mode in Note Manager(refer
to the user manual)

The distance between
the pen and the base
unit is beyond the
area of A4 paper.

Make sure the distance
between the pen and the
base unit is within the area
of A4 paper.

The orientation of the
pen strokes does not
match the actual
writing or drawing.

Setting your base unit
orientation as the
same to your actual
placement.

See "Setting your base unit
orientation preferences"
section in the user manual.

Chapter 10 Technical Specifications

Item

Description

System Requirement

3. 32 bit color quality

1. Minimum 50MB available hard disk space
2. Minimum 128MB RAM

4. Screen resolution of 1024x768 pixels

56




5. Available USB port

6. Microsoft ® Windows 2000 (SP4), Microsoft ®
Windows XP (SP2), Microsoft ® Vista, Windows 7 or
later version.

Work Mode Note and Mouse
LCD Screen 132X32 lattice
Battery Type Rechargeable lithium-ion battery
Battery Life About 6 hours
Charge Time About 3.5 hours
Coverage area A4

Capacity 100 A4 pages
Storage Temp* -20 ~ +65
Ambient Temp* 5 ~+55
Operation Relative 20% ~ 90% 40
Humidity*

Storage Relative Humidity*

20% ~93% 40
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